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Links 
 

 
“Page-O-Links” 

 
 

•  Watts Digital Home Page (Products & Services):   
 

 https://wattsdigital.com 
 
 

•  Join my mailing list to receive my Watts Digital Photoshop “Quick Tip” Newsletter:   
 

             Click Here to Join 
 
 

•  Photoshop free live Meetups online:   
 

https://wattsdigital.com/free-live-meetups-online 
 

 

•  “Not Just Another Photoshop Book”:  
 

       http://www.amazon.com/dp/B07HNLS1Q2 
 

 

•  Free Useful Downloads: 
 

https://wattsdigital.com/free-useful-downloads 
 

 

•  Free “Photoshop 101” Videos: 
 

            https://wattsdigital.com/free-photoshop-101-videos 
 
 

•  Free Photoshop YouTube Videos (Don’t forget to subscribe & “like”): 
 

            https://www.youtube.com/user/wattsdigitalvideos 
 
 

•  Blog Home Page (Educational): 
 

       https://blog.main.wattsdigital.com 
 
 

•  Blogpost: New to Photoshop?  Need a “Lesson Plan”?  Read this post! 
 

https://blog.main.wattsdigital.com/?p=3612 
 

 

•  Blogpost: What is a Master File, and why do I need one? 
 

https://blog.main.wattsdigital.com/?p=1853 
 
 

•  Blogpost: Photoshop vs Lightroom?  Wrong Question! (Links to Part 2& 3 in this blogpost) 
 

     https://blog.main.wattsdigital.com/?p=1840 
 
 

•  Blogpost: The Philosophy of RAW: 
 

https://blog.main.wattsdigital.com/?p=2215 
 
 

•  Blogpost:  Camera RAW 12.3 - RADICAL changes to the User interface: 
 

https://blog.main.wattsdigital.com/?p=3025 

https://wattsdigital.com/
https://visitor.r20.constantcontact.com/manage/optin?v=0016DNjNiidDhRwYuGZFNAxcASo2U_gpD08
https://wattsdigital.com/free-live-meetups-online
http://www.amazon.com/dp/B07HNLS1Q2
https://wattsdigital.com/free-useful-downloads
https://wattsdigital.com/free-photoshop-101-videos
https://www.youtube.com/user/wattsdigitalvideos
https://blog.main.wattsdigital.com/
https://blog.main.wattsdigital.com/?p=3612
https://blog.main.wattsdigital.com/?p=1853
https://blog.main.wattsdigital.com/?p=1840
https://blog.main.wattsdigital.com/?p=2215
https://blog.main.wattsdigital.com/wp-admin/post.php?post=3025
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Think of this workshop as the “Owner’s Manual” to Photoshop - - I’ll show you how to effectively navigate 
through a complex program. 
 
You’ll learn those functions that you really need and want as a photographer. You’ll learn what’s important and 
what you can ignore (heck, you’ll only need to use about 10-15% of the program!).  Without this “Owner’s 
Manual”, you’ll truly be lost.  
 

Like most Owner’s Manuals, this workshop is not glamorous or exciting - It’s the automotive equivalent of 
how to turn on your car, how to put your car in gear, where are the windshield wipers, and so on – basic but 
necessary stuff. 
 
 

 

 
 
 
 
 
 
 
 
 
 
 
 

This could be the most “boring” Meetup  

of the 5 “Photoshop 101” Meetups, 

so please don’t get discouraged -  

it’s “foundational” stuff,  

and you’ll refer to these notes frequently. 

 

Learning Photoshop is a marathon, NOT a sprint! 
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Teaching Philosophy / Method 
 
 
 
 
• I don't plan to teach you how to put children's heads on animals, or make flashing and rotating text, or how 

to create a surreal, mind-blowing digital masterpiece that defies logic.  There’s a place for it, but that’s not 
my “gig” (think: Graphic Design / Photoshop Artistry) - I teach Photoshop to and for photographers.  

 

• What I can teach you is how to make a great color print / image using the basics of Photoshop to 
achieve your desired results. I think of Photoshop as my "digital enlarger."  -- What I once used to do on a 
darkroom enlarger in the analog world I can now do in Photoshop with lots more control and options. 

 

• Why should you listen to me?  The same reason that you listen to your doctor: training and experience.  
Like your doctor, I've learned what generally works and what doesn't.  Also, like your doctor, I'm constantly 
learning new things, and listening to new ideas (a doctor "practices" medicine, after all!)  -- Hence, this book 
… 

 

• Although there’s quite a bit of information available about PS, I’m NOT going to teach you a complete 
“Photoshop encyclopedia” – instead, I’ll focus on getting you up and running with a minimum of hassle, 
master the fundamentals of Photoshop, and get great results.  Once you master the material I’ll teach you, 
you’ll be able to expand your “Photoshop Horizons”, knowing you’re starting with a solid foundation. 

 
 

__________________ 
 
 

 

• Think of my teaching method / philosophy as being analogous to a “Manual Transmission” (vs. an 
“Automatic Transmission”) in a car.  A manual transmission is mechanically simple, but will give you tons 
of control & higher performance over your automobile (they don’t use automatic transmissions in NASCAR, 
after all!).  But it comes with a price:  a “learning curve” – hand/eye/foot co-ordination, and so on.  After a 
time, using a manual transmission becomes instinctive, and you don’t even think about “stalling the car” 
anymore. 

 

• What I’m going to show you in Photoshop is the same way – simple, but tons of control & high 

performance!  And don’t worry; you won’t “stall the car” nearly as much while learning this ☺ 
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Conventions, Concepts and Controls 

 
 

 
 

 
 
 
 
 
 

Conventions: 
 
• Heed the advice of the old adage – G.I.G.O. - "Garbage In, Garbage Out" (and its corollary “Good In, Good 

Out”).  You need to start with a good digitized image that is well exposed and composed.  Although 
Photoshop is a very powerful program, it is not a "miracle" program, able to turn trash into diamonds.  
Somewhere along the way, in the transition from analog/film to digital, some photographers have gotten 
sloppy in their photographic discipline -- "Oh, I can fix it in Photoshop". 
 
 

• Photoshop is just a tool -- a very powerful tool, but a tool nonetheless.  I think of it as my "digital enlarger."  -
- What I once used to do on a darkroom enlarger in the analog world I can now do in Photoshop with lots 
more control and options. 
 

 

• K.I.S.S - Employ the K.I.S.S. Method - "Keep It Super Simple".  Start with the basics of Photoshop and grow 
into other functions as you need them.  Most of the time, you will only need to use 10% to 15% of 
Photoshop's functionality to achieve the results you want, and you can pretty much ignore the rest.  
Sometimes, less is more, or as a client recently put it: “Simplify and Demystify”. 
 

 

• When it comes to working with Photoshop, there are zillion ways to get the job done.  That being said, I’ve 
found that the methods that I’ll show you are the simplest, most effective and least "destructive” to your file 
to achieve the desired results.  They are also time-tested in a commercial and artistic working environment. 
 

 

• I've also found that the generic tools such as “Brightness/Contrast” or “Color Balance” controls are too 
global, simplistic or destructive to the image to be of any major use - think “Manual Transmission vs 
Automatic Transmission”.  By the way, I define “Destructive“ as causing pixelization and posterization to 
your digital image, resulting in bad files and prints. 
 

 

• Practice, Practice, Practice!  -- Just like any other activity worth pursuing, you will get more proficient and 
faster at Photoshop the more you practice. 
 

 

• There are two excellent sources of information, often overlooked: 1) The “Help” section included with 
Photoshop, and 2) The Internet.  The “Help” section in Photoshop is excellent for explaining how something 
should be done, but not necessarily why.  The Internet offers a multitude of videos, tutorials, and so on -- but 
like anything else on the Internet, you should take some of it with a grain of salt. 
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The next three pages discuss some of the fundamental Conventions, Concepts, and Controls used 
throughout Photoshop – these are critical “habits” to get into.  Keep in mind that these fundamentals 
are discussed throughout the book, so don’t get hung up on the details at this point.  If something doesn’t 
make sense right now, just move on – you’ll more than likely be referring back to these notes frequently. 
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Concepts: 
 

 

• Be safe with your original image files! In case of major mistakes, file corruption, loss of data, and so 
on, it’s important to make sure that your original file is safe: 

 

Always duplicate, rename and work on the copy of your original file, whether it’s RAW, JPG, 
TIFF, etc. (discussed in the Workflow Chart - see “Class 4” & “Useful Downloads” link) 

 
• Create a “Master File” – The “goal” is to create a multi-purpose un-flattened “Master File” for each 

image that you wish to enhance.  From this Master File, you can “re-purpose” your file for a specific print 
size, for the Web, for magazine output, and so on (discussed soon). 

 
• You can work “Globally” as well as “Locally” -- One of the biggest advantages to Photoshop is the 

ability to make corrections and adjustments “Locally” (affects only a portion of your image) by making 
selections (covered in another workshop).  In the old analog world, corrections will almost always 
“Global” (affects the whole image), particularly color corrections (See Class 2). 

 
• Work in Adjustment Layers -- Think of adjustment layers as transparent overlays over your image, 

each layer doing something different (i.e. contrast control, color correction, etc.).  For further control, you 
can also adjust the opacity of each layer separately (as a percentage), in the "Layers” Panel. 
(Adjustment Layers are discussed in-depth in “Class 2”) 

 
• Standardize your Workflow – It is important that you work on the various steps of your image in the 

order shown on the Workflow Chart (available in “Useful Downloads”):  For instance, Contrast should be 
adjusted before your Color is corrected, Touchup should be done before Sharpening, and so on. 

 
• Tonal Compression:  This is the inevitable reduction /degradation of the original scene from your eyes 

to the print. It’s pure physics - the range of colors reproduced shrinks throughout the process.   Let’s 
say, for example, that our eyes see 100 shades of red.  The camera, shot in RAW, may see 70 shades.  
Then Photoshop may see 60 shades of red, and the printer may only print 45 shades of the original 100 
shades available. 

 

So, how can you minimize some of the effects of tonal compression?  Three things:   
 

- Shoot in RAW (or scan in 16 bit) 
- Use a proper Color Working Space in Photoshop (discussed in this class & Class 5) 
- Have your Color Management “house” in order (discussed in Class 5) 

 
• If you start with a “16-bit” file, then work in “16-bit” as long as possible -- If your original image is 

in 16-bit, such as a RAW file, keep working in 16-bit as long as you can in Photoshop – at least through 
the creation of your Master File.  It’s much better to work with 65,000+ values of each color (16-bit) than 
255 values of each color (8-bit).  

 
8 Bit: 255 values of each color x 3 (RGB) = 17.7 Million combinations of RGB Color 
 
   

16 Bit: 65,000+ values of each color x 3 (RGB) = 281 Trillion combinations of RGB Color 
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Controls: 
 
 

• Work in Adobe 98 RGB (or in ProPhoto RGB) color space – A Color Space, by the way, is defined 
as "a system or color model for describing color numerically".  If your color settings are set up as 
suggested later in this class, you’ll already be working in this space.  This is a great general-
purpose color space for digital photography (A large “bucket” of colors).  As an aside, I would not use 
sRGB – it’s a consumer-based color space and the “bucket” is way too small. 

 

• By the way, you should be shooting your JPG images in Adobe 98 RGB in your digital camera, 
not sRGB - - again, it’s a much larger color space and you will capture more information – consult your 
camera’s owner’s manual on how to change it 
 

• Also, note that a RAW file does not use a Color Space – A RAW file is just lots of information. 
 

• Save your image frequently as you are working -- I like to save every time I add a new layer; that 
way, I don't forget.  In Mac, the speed key combination is “Command + S”, and in Windows it is “Control 
+ S”.  It is also imperative to back up and archive important files on a regular basis in case you have 
computer problems. 

 

• Save your important images / Master Files as TIFF or PSD files, not JPG files (discussed in Class 
3) - Three reasons: 

 

• Every time that you open, work on, and save a JPG, there is degradation because the JPG 
compression scheme is not “lossless” - a TIFF or PSD is “lossless” 

• You cannot save a JPG in 16 Bit 

• You cannot save a JPG with Layers 
 

• Save your Master Files at 300 pixels/inch -- This is the optimum PPI (pixels per inch) setting for 
viewing, prepping, and printing your image.  To check this, go to the "Image" menu → "Image Size…". 

 

• Turn on Photoshop’s "Ruler" for easier viewing of your image -- I like to have the Ruler turned on 
in the Document Window as it seems to give the image a sense of perspective.  To toggle it on and off, 
use the speed keys: “Command + R” for a Mac, and “Control + R” for Windows. (or “View” menu -> 
“Rulers”) 

 

• To see what your image will look like size-wise in "the real world" on your monitor, determine the 
proper image magnification (at 300 PPI) for viewing your image as close to “actual size” as possible.   

 
To determine this, turn on Photoshop’s “ruler”, hold a physical ruler against your monitor, then zoom in 
or out on your image until an inch on your image equals close to an inch on your physical ruler – the 
magnification shown in your Document Window is your 1-to-1 viewing magnification.  For most monitors, 
this will be 25% magnification, but on some higher-resolution monitors, it can be much higher. 

 

• Flattened versus Unflattened Files -- A flattened file has all of the layers "Collapsed" in the Image to 
reduce file size.  A flattened file is best for printing.  An unflattened file has all of the layers 
"expanded" in the Layers Panel.  A Master or Archive file (discussed later) should be unflattened so that 
you can easily make corrections later nondestructively (meaning no loss of data/pixels). To Flatten all 
Layers, go to “Layer” menu -> “Flatten Image” 
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The Master File and Workflow 
 

 
If a picture is truly worth a thousand words, then here’s an overall visual representation of the linear  Workflow 
Chart near the beginning of the book (& discussed in Class 4)– notice that your Workflow centers on creating a 
Master File.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Creating a Master File is NOT for every image: it’s for those images that you want to spend time with, doing all 
that’s necessary to make your image “pretty”.  Here’s where you pour your artistic “blood, sweat and tears” into 
your image, using the methods shown in this book. 
 
What is a “Master File”? It’s a 16-Bit, un-flattened, un-sharpened, un-cropped, un-resized file, designated as 
such in its file name, and saved as a .PSD or .TIFF (all of this discussed later throughout the various classes). 
 
Why create a Master File? 
 

• It’s Multi-purpose: Use it to create separate files for a specific print size or printer, for the Web, for 
magazine output, etc. and you’ll stay consistent between those files. 

 

• It’s easily correctable: for color, contrast, cropping, enhancements, etc. non-destructively (loss of digital 
information). 

 

• Sharpening is applied according to your print size, and NEVER to your Master File: Let’s say that your 
Master File is created from a RAW file – It might be around 12”x18” at 300 ppi – If you sharpen for this 
size and reduce the file to prep for an 8x10 print, it will be over-sharpened.  

 
 

 
 

 

 

By the way, the left side of the chart above is the “creative” side, and the right side of the 
chart is the “procedural” side (except for cropping, which can be very “creative”). 
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Save your Master Files as TIFF or PSD files, not JPG files:  
 

It is important to save your Master Files as TIFF’s or PSD’s, not as JPG’s.  Again, just to reiterate, there are 
three reasons: 
 

• Every time that you open, work on, and save a JPG, there is degradation because the JPG 
compression scheme is not “lossless” - TiFF’s and PSD’s are “lossless” 

• You cannot save a JPG in 16 Bit 

• You cannot save a JPG with Layers 
 

 
 

TIFF vs PSD: 
 

My personal preference is to save my Master File as a .PSD, so as to further differentiate between my Master 
File and all other files - plus, a .PSD file saves faster, and has built-in “lossless” file compression, resulting in 
slightly smaller Master Files. 
 

Other than that, there are no major differences between the TIFF format and the PSD format. 
  
That being said, there are two related situations in which you might want to save your Master File as 
a .PSD rather than a .TIFF: 
 

1. Your original file is large to begin with (over 200 MB) 
2. Your Master File becomes large (over 200 MB) 

 
Examples: 
 

• It’s not unusual for me to work with 200 to 400 MB 16-bit Drum Scans from film transparencies, and 
a Master File with many layers can easily become 600 or 700 MB, which makes things very 
cumbersome and slows down my computer tremendously if I save the Master File as a TIFF- not so 
if I’m working in the .PSD Format.  

 

• If I’m working on a complicated RAW file that involves a lot of specialized layers, my Master File could 
easily get bigger than 200 MB, even though my original RAW was only 20 MB or so, again slowing 
down my computer if saved as a TIFF - but not in a .PSD format. 

 
 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  
Here’s a link to one of my free videos (“Class 4”, recorded live) that perfectly 
encapsulates how best to use Photoshop for the Photographer, with a diverse 
range of images - This is Master File Creation & Workflow in action! 
 

• Think of it as a “study” video, if you will – heck, it’s an hour & twenty minutes 
long! You can download copious notes), including a Table of Contents – just 
in case you cannot watch it all in one sitting, or need to refer back to it (and 
you will!). 

 

See the video here (QR Code to the right): 
https://blog.main.wattsdigital.com/?p=2452 
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General Preferences / Screen Colors 

 
 

 

Purpose:  
 
 

The purpose of the suggested “General Preferences” set up is to make your preferences in sync with 
those functions best needed for photography, as well as what you will learn in this and future 
workshops. 

 
Where to Find: 
 
 

• Menu:  “Edit” → “Preferences…” on a PC, “Photoshop”  → “Preferences…” on a Mac 
 

• Speed Keys:  “Control + K” on a PC, "Command + K” on a Mac 
 

 
You should leave all settings in your General Preferences at the default settings until you gain more 
experience with Photoshop, except for the five shown below (these may not make sense right now, but they 
will as we further explore Photoshop): 

 

 
1. Click the "Tools" tab on the left, check 

on "Zoom Resizes Windows."  -- This 
anchors the canvas size to the image 
size, allowing ease of navigation. 

 
2. While still in the "Tools" tab, check 

"Show Tool Tips" -- This allows you to 
place your mouse cursor over a tool, 
button, control, etc. and have a small 
"balloon" pop-up telling you what the 
item is (as well as its speed key, where 
applicable). 

 
3. Now go to the "History Log" tab, check 

on History Log, then choose 
“Metadata” and “Detailed” from the Edit Log Items drop-down list. You can then view the History Log for 
an open image by going to "File” -> ” File Info…” -> “Photoshop”. 

 
4. Go to the "Workspace" tab, uncheck “Open Documents as Tabs”, if you desire - - I rarely use this 

function (unless I’m opening a bunch of similar images at once), as it anchors the document to a fixed 
place in the program - I find it impairs my workspace navigation. 
 

5. Last, go to the "Interface" tab to reduce or enlarge your program’s overall UI Font Size.  I use "Medium" 
(but I have older eyes, lol) - adjust to taste.  Make sure and check the box, “Scale UI To Font”. 
 

 

By the way, don’t forget to click “OK” when leaving the preferences dialog box to save your changes - some 
changes may not take effect until you close and restart Photoshop! 
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Photoshop Interface Color Theme: 
 
 

 By default, the interface gray color theme for Photoshop CS6 / CC is quite dark. If you (like me) don’t 
like this dark interface, you can easily change it to a lighter gray color theme.  Go to “Preferences…”, 
click the "Interface..." tab on the left, go to the top under “Appearance” and click on the preferred box. 

 

 
 
 
 

Screen background and menu colors: 
 
 

Give yourself an edge and choose the best conditions for judging color balance on your computer 
monitor(s): You should make your non-Photoshop screen background and menu colors a neutral color, such 
as gray.  You should replace any menu or background colors that compete for your attention, such as bright 
blue, aqua, and so on.  It is much harder for your eyes to judge color accurately when there are a lot of bright 
extraneous colors on their periphery to distract them. 

 

• On a Mac: 
 

To change the menu appearance, go to "Finder → Applications→ System Preferences → 
Appearance".  I suggest "Graphite" for the ”Button and Menu Appearance”.  

 
For the Highlight Color, go to "Other", choose "Color Sliders", then "RGB Sliders", and set your sliders 
to RGB 127/127/127 (approximately medium gray). 

 
For the monitor background color, go To “System Preferences” → “Desktop and Screensaver”, and 
select the "Desktop" tab.  Choose "Solid Colors", then "Solid Gray Medium" (Do this for both monitors, 
where applicable). 

 

• On Windows: 
 

Right mouse click on your desktop, and choose "Personalize".  Now choose "Window Color and 
Appearance".  When the "Appearance Settings" menu pops up, press the "Advanced..." button; the 
“Advanced Appearance” menu opens.  Choose "Desktop" as your "Item". On the drop-down "Color 1" 
menu, choose “Other”, and choose an RGB value of approximately 150/150/150. 
 
While the "Advanced Appearance" menu is still open, choose "Active Title Bar" from the "Item" drop-
down menu.  For "Color 1", I would suggest an RGB value of approximately 75/75/75.  For "Color 2", 
your RGB value should be approximately 95/95/95.  Press "OK “, then “Apply”, then “OK”. 
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Color Settings Menu 
 

 
 

Purpose: 
 

These settings will allow you to correctly "Color Manage" for consistency and repeatability.  

 

Where to Find: 
 

Menu: "Edit”  → “Color Settings” on a Mac or PC. 
  

Speed Keys: "Command" + "Shift" + "K" on a Mac, "Control" + "Shift" + "K" on a PC. 
 

 

To Set Up: 
 
 Choose “North America Prepress 2” from the “Settings” drop-down menu.  By doing this, you’ll set your 
“Working Space to Adobe RGB (1998) - See “Controls” for more on “Working Spaces”. This setup operation 
only has to be done once. 

 
 

 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

“Profile Mismatch” Warning: 
 

Now that you have told Photoshop what your working space is, it will 
not be unusual for you to see the above dialog box pop up when you 
open a file, particularly if you're shooting your image is any color 
space other than Adobe RGB 98 (such as “sRGB”). 
 
As you can see, you have three choices when you have a profile 
mismatch: You will want to choose the middle option, "Convert 
document’s colors to the working space" for proper Color 
Management.  

 
By the way, you can avoid this warning by shooting your JPG’s in Adobe RGB 98. 
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Setting up your Workspace with Panels 
 
 
 
See a 5-minute video on this chapter here (QR Code to the right):  
https://blog.main.wattsdigital.com/?p=1731 

 
Think of Panels as miniature workspaces, each accomplishing a different function.  There are almost two dozen 
different panels available to you, but in the spirit of K.I.S.S., I would suggest that you start with just nine, and add 
those you deem necessary as you gain more experience with Photoshop. 
 
Below is a representation of the panels I would suggest that you set up on your Photoshop desktop to create a 
proper workspace: 
 
Photoshop gives you a set of predefined workspaces: You can access these by going to the “Window” menu 
→ “Workspace”.  I would start with the preset “Photography” Workspace, then I'd suggest that you add or 
subtract panels until you end up with just the following in your workspace: 
 
 
 
 
 
 
1. Tools panel 
2. Layers panel 
3. History panel  
4. Actions panel 
5. Navigator panel  
6. Info panel  
7. Histogram panel 
8. Adjustments Panel 
9. Properties Panel 
 
 
 
 
 
 
 
 

 
 
 
 
 
 

Why these Panels? 
 

These nine panels are the ones that you’ll use most.  As it is important to keep things simple (Remember K.I.S.S.!), 
stick with these to start – you cannot go wrong.  

11 

Feeling adventurous?  Install a custom Photoshop Workspace 
Preference (.psw) file to help you get started (QR Code to the right): 
https://wattsdigital.com/free-useful-downloads 
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Working with Panels in the Workspace: 
 

• You’ll notice that certain panels are “docked” to each other into Tab Groups: this is to save valuable 
“screen real estate” (By the way, "screen real estate" is not as critical if you use more than one monitor).   

 

• To add or remove a Panel from a Tab Group, click on the Tab, hold down your left mouse button, and 
drag it into or out of the Group. 

 

• To add a Panel to your workspace, go to the 
“Window” Menu, and simply place a 
checkmark beside the panel you wish to add. 
(Checked Panels are those visible in your 
Workspace)  

 

• To move a Panel, place your mouse pointer 
over the name of the panel (the “tab”), you’re 
your left mouse button down, and drag it to the 
desired location in your Workspace or Tab 
Group. 

 

• To resize a Panel (where available), place your cursor over the bottom right corner 
of the panel, and your pointer will turn into a double sided arrow.  Hold your left mouse 
button down, and drag the panel to the desired size. 

 

• To delete a Panel, simply click on the "x" to the right of the name in the tab.  You may 
have to remove this panel from a Tab Group to see it’s “X”.  Don't worry if you 
accidentally delete a panel you need: you can go to the “Window” menu and “re-check” 
it.  

 

• To minimize a Panel or Tab Group, click on the double arrow on the top right of the 
Panel or Tab Group. Click the double arrow again to expand to normal size. 

 
Panel Options:  In each panel, you’ll notice a downward facing triangle with three parallel lines next to it in the 
upper right-hand portion of the panel.  This gives you access to the Panel Options.  Each panel will have a different 
set of options such as the size of the icons in the panel, the view available to you, and so on.  You should explore 
these – For instance, I personally like larger icons in my layers panel. 
 

Hide All Panels: If you’re limited with screen “Real-estate” (small laptop, etc), use the “Tab” Key on your keyboard 
to hide all of your panels – perfect for looking at your images with a critical eye. Simply use the “Tab” Key again 
to get back to your Panels. 
 

Maximize your Workspace: To avoid distractions, it’s a good idea to “maximize” the Photoshop Program on 
your computer so that it “fills” your screen, avoiding other programs, icons, backgrounds, etc that might interfere 
with your Workspace. 
 

To save your Workspace:  Once you have set up your workspace, you can save it.  Go to "Window” → 
"Workspace" → "New Workspace...", and when prompted, give it an appropriate name, then save it.  You can 
easily access it again 3 ways: 
 

1. "Workspace" →  then click on your saved workspace in the menu choices  
 

2. By clicking on the icon in the upper right corner of your Photoshop Workspace 
 

3. By Resetting your Workspace: "Workspace" → "Reset (Name of Workspace)" 
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The Tools Panel and the Color Picker 

 
 
See a 5-minute video on this chapter here (QR Code to the right):   
https://blog.main.wattsdigital.com/?p=1750 
 

 

Purpose: 
 

The Tools Panel and the Color Picker allow easy access to the some of the most commonly used tools and 
functions in Photoshop. 

 
 

Where to Find: 
 

• The Tools Panel is generally found on the 
left side of your screen.  You have two view 
options: a single column view, and the 
“classic” double column view.  To change 
the view, click on the double arrow at the 
very top of the tools panel. 

 

• The Color Picker can be accessed 
throughout the program.  The most common 
way to access the Color Picker is to click on 
the foreground or background color in the 
Tools Panel: the Color Picker will then pop 
up.   

 

• You also have access to the Color Picker in 
many other functions, such as the Text Tool, 
the Line Tool, and so on.  Generally 
speaking, any time that you see a square or 
rectangular box with a color in it, you can 
click on the box and access the Color Picker. 

 

 

The Tools Panel: 
 

There are over 50 tools contained in the 
Tools Panel.  Not only are there around 20+ 
tools showing “on top”, but wherever there is 
a triangle in the bottom right-hand corner of 
the tool, there are more tools underneath the 
tool on top.  
 
Don’t be overwhelmed: you will only need a 
handful of these on a regular basis (shown 
above and covered in detail throughout the 
various “Photoshop 101” classes). 

13 

https://blog.main.wattsdigital.com/?p=1750


 

 

Seminar – Photoshop 101: The Foundation – 02/07/24                                                         John M. Watts, Jr. 

 
 

Working with the Tools Panel: 
 

• The diagram to the right shows an example of tools "hidden" underneath the top tool once “expanded”- 
access by clicking & holding on the “triangle”.  

 

• Beside most tools in the diagram on the 
previous page is a keystroke in parentheses 
-- this is the tools’ speed key.  All single-digit 
Speed Keys in Photoshop are reserved for 
the Tools Panel for ease of use. 

 

• When the mouse cursor is placed over a tool, 
the name of that tool appears below the 
cursor as a tool tip, along with that tools’ 
speed key. 

 

• Notice that for each tool selected, a new 
"Options Bar" in will show up.  The Options Bar is a menu of options at the top of the Workspace, and 
is unique to the tool selected.  For example, the Options Bar shown below appears when the Magic Wand 
Tool is selected. 

 
 
 

 
 
The Color Picker: 
 

• The color picker is easiest to use for 
a Photographer’s purpose when the 
"H" radio button is selected. 

 

• To change the color – 3 ways: 
 
o Click in the Color Palette 

and/or drag the “Circle” cursor 
(Circled in red in the diagram on 
the right) to change the 
Brightness and Saturation.  

 
o Move the Sliders in the vertical 

rainbow-colored bar to change 
your Hue. 

 
o Enter the RGB values directly 

into the boxes to the right of the 
letters R, G, and B. 

 
▪ If your RGB values are 0/0/0, then the color is black.   

▪ If your RGB values are 255/255/255, then the color is white.   

▪ If your RGB values are all of equal value, such as 127/127/127, then the color is a shade of grey. 
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The Navigator and History Panels 
 

 
See a 5-minute video on this chapter here (QR Code to the right):   
https://blog.main.wattsdigital.com/?p=1812 

 
The Navigator Panel 
 
 
The Navigator Panel allows you to “navigate” 
around your image at large magnifications. 
 

 
• When your image is enlarged bigger 

than your Document Window, simply 
drag the “Red Box” with your mouse to 
the desired location 

 

• Notice that the magnification of your 
image shows at the bottom, along with 
Sliders to reduce and enlarge. 

 

• This is also a good time to review these 
navigation “Speed Keys”, as this is 
where you’ll use them in conjunction 
with the Navigator Panel: 

 
________________ 

 
View: (Mac in Parentheses) 
 

Control (Command)  +  " + "   Enlarge Image Size 
 

Control (Command)  +  " - "   Reduce Image Size 

 
Control (Command)  +  " 0 "   Fit to Monitor Screen 
 
"F" Key     Toggle through Standard & Full Screen Modes 
 

"Tab" Key     Toggle to Show/Hide all Panels 
 
 
Navigation: 
 
"Navigator" Panel    Drag with mouse to desired location 
 
"Space Bar" Key + Left Mouse Button  Drag with mouse to desired location 
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The History Panel 
 

 
 
Use the “History Panel” as well as the “Visibility” and “Trash” 
Icons in the Layers Panel frequently (discussed in Section 4) -- 
These are excellent ways to discover "what-if" scenarios and/or to 
make instant corrections on your image. 
 

• Every time you perform a function that changes your file, a 
“History State” is created - Click on the name of your 
desired location above the last entry to go back in “History”. 

 

• By default, Photoshop will save 50 History States – you can 
change it in “Preferences” -> Performance” (See the section 
on General Preferences to access), but probably don’t need 
to – any more history states, and you’ll start to slow down 
your computer. 

 

 
 

Keep in mind 3 things: 
 

• If you go back and forth between various History States, and don’t work on and change your image, all 
the history states that follow are saved. 

 

• If you go back to a previous History State, then change your image, all the history states that follow are 
dumped. 

 

• When your image is closed in Photoshop, all of the current History States are lost – This is one reason 
you work in Adjustment Layers, discussed in “Class 2”. 

 
 

 
The History Log 
 

If you activated the “History Log” in “General Preferences”, a 
“History Log” is created (including what you did in Adobe 
Camera RAW, discussed in Class 3) in your Metadata. 
 
This log can be accessed (with an image opened that 
you’ve previously worked on) by going to "File”  -> ” File 
Info…” -> “Photoshop”. 

 
 

 
 
 
 
 

16 



 

 

Seminar – Photoshop 101: The Foundation – 02/07/24                                                         John M. Watts, Jr. 

 
 

The Document Window 
 

 
 
There is quite a bit of information that can be gleaned from the Document Window, without opening separate 
menus to find that information elsewhere.  
 
Take a look at these – They are highlighted in red in the diagram below (Some of these items need no explanation 
and some may not make sense right now – We’ll explore them later in future workshops): 
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A few things to note about the Document Window: 
 
 

• I personally like to have the Ruler turned on as it seems to give the image a sense of perspective. Go to 
“View” menu -> “Rulers”. 

 

• If your open document has not been saved, you’ll see an asterisk OUTSIDE the parentheses. 
 

• (Note: You may not see this one very often!) If your “Color Working Space” for the open document is 
different than what you set as your “Default Color Working Space” in your “Color Settings”, there will be 
an asterisk to the right of “Bit Depth”, and INSIDE the parentheses.  

•  
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See the methods taught in my PS book come to life! 
 
•  Free “Photoshop 101” video recordings, covering all of the basics ... 
 

•  All recorded through my San Diego Photoshop Meetup - come join us - -  
   free, online, live & nationwide! 
 

See the videos here: 
 

https://wattsdigital.com/free-photoshop-101-videos 
 

Free live & online Photoshop Meetups - available nationwide: 
 

https://www.meetup.com/San-Diego-Photoshop-for-Photography/ 
 

(or use the QR Codes below) 

Free Videos Free Photoshop Meetups 

https://wattsdigital.com/free-photoshop-101-videos
https://www.meetup.com/San-Diego-Photoshop-for-Photography/
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Changing Numerical Values / The Cursor 
 

 
 

 

Changing Numerical Values: 
 

There are three main ways to change the numerical values in Photoshop’s various tools, adjustments and 
functions (and Adobe Camera RAW Plug-in, see “Class 3”): 
 
 

1. Move the desired slider with your left mouse button held down to increase or decrease the value.  
This works well for coarse adjustments. 

 

2. With your cursor placed in the numerical value box, use the arrow keys on your keyboard to make 
small incremental changes.  This works well for fine-tuning adjustments. 

 

3. Insert numerical values with your keypad manually in the appropriate box.  This works well if you 
have a particular numerical value in mind, but is rarely used.  

 
The example below is from a Levels adjustment Layer: 
 
 
 

 
 
 
 
 
 
 
 
 
 

 
• To move quickly between numerical fields, you can use the “Tab” key or the “Shift + Tab” Keys. 

 

• In certain adjustments, most notably in Adobe Camera RAW (ACR) – To quickly return a value to its default 
or “zero” value, double-click on the “triangle-shaped” Slider for that value. 
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The Cursor: 
 
 
Don’t like the Mouse Cursor Shape as it shows up in your image?  Can’t seem to find your cursor?  Or you keep 
clicking in the image, and something happens that you don’t expect? 
 
Simply change the Tool in your Tools Panel to something less likely to give you a weird result if you click 
accidentally in your image. - - I like the Hand Tool (Speed Key “H”) and the Move tool (Speed Key “V”), and 
they’re both easy to see in your image. 
  

 
      
 
 
 
 
 
 
 
 
 
 
 

• In Image 1, the active tool is the Magic Wand Tool represented by the icon circled in red. – It’s fairly 
easy to see, but if you accidentally click in your image with it active, you’ll be making an unwanted 
selection. 

 

• In Image 2, the active tool is the Hand Tool - It’s very easy to see, and very hard to mess up your image, 
as it’s just a navigation tool. 

 

• In Image 3, the active tool is the Move Tool - It’s also easy to see, and, unless you’re into heavy-duty 
graphics not covered in this book, it’s also difficult to mess up your image. 
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Opening, Duplicating and Renaming Files 

 
 
 

 
3 Main Ways to Open a File in Photoshop: 
 

• Go to the “File” Menu -> “File” -> “Open …” – choose your file, and press “Open” in the Dialog Box. 
 

• Double-click on the Workspace background to bring up the “Open …” Dialog Box. 
 

• On a Mac: Create a Photoshop Icon in your Dock, then drag your desired file to it. 
  
On a PC: Create a Photoshop Shortcut on your Desktop, then drag your desired file to it. 

 
 
 
2 Ways to Duplicate a File: 
 

• In Photoshop:  Go to the “Image” Menu -> “Duplicate …” and choose your desired filename.  
 

• On a Mac:  Right-mouse click on your file, then choose “Duplicate” from the menu. 
 
On a PC:  Right-mouse click on your file, and choose “Copy” from the menu – then Right-mouse click 
anywhere, and choose “Paste” from the menu – your duplicated file will show up in the same general 
area / file location as your original, with the word “copy” included in the filename. 

 

 
 
Rename a File 
 

• The best way to rename a file is NOT in Photoshop, but in your computer’s operating system. 
 

• For both Mac and PC, simply right-mouse click on your file, choose “Rename” from the menu, and type 
in your new filename. 
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“Save” Options / File Naming Conventions 

 
 
 
When saving files, Photoshop gives you two main options: "Save..." and "Save As...".  You can find both of these 
under the “File” menu (along with their respective Speed Keys). 
 

• With "Save...", you'll be saving your file with the existing name, in it’s current location.   
 

• With "Save As...", you have the option of changing the name, location and file format. Here’s how it 
works: 

 
1. The first Dialog Box you’ll see is your 

Operating System’s “Save/Save As..” Dialog 
Box.  
 
Choose the name, location and File Format that 
you desire – Leave the Adobe RGB (1998) 
Profile box checked. 

 
2. The first time that you save your file as a TIFF, 

Photoshop’s TIFF Options Dialog Box pops 
up: 
 
Generally speaking, you’ll rarely need to change 
these TIFF Options settings.  So, in the spirit of 
K.I.S.S., just Press “OK” without changing the 
default settings, and your file is saved. 

 

A few things to consider when saving your files: 
 

• The best format to save your Master file for 
archiving is an unflattened (still has layers) PSD 
or TIFF. 

 

• The best format to save your image for printing is 
a flattened (no layers) TIFF. 

 

• The best format to save your image for the Web 
or email is a JPEG (@ 72 PPI).  

 

• For all practical purposes, there is no difference 
between the TIFF format and the PSD format (See “The Master File & Workflow” for more on this). 

 

• You should get in the habit of saving your image frequently as you work.  It’s extremely frustrating if your 
computer crashes or freezes after spending any amount of time with a particularly difficult function.  I 
tend to save every few minutes as I work.  A good habit to get into is to save every time you create a 
new layer -- it's a simple matter of quickly pressing the speed key combination -- "Command” + S” on a 
Mac and “Control” + S” on a PC. 
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File Naming Conventions: 
 

It is important to establish and use an easy-to-understand naming convention.  Of course, everyone will 
develop their own system, but let me make some suggestions: 
 

• I typically include “_M” at the end of a filename for an unflattened “Master File”.   
 

• For a flattened file ready for printing, I will instead include a print size, such as “_11x14”, at the end 
of a filename.  

 

• It won’t be unusual to have multiple files from the same original image - your original RAW file, your 
duplicated and renamed RAW file (and .xmp “sidecar” file), your Master File, a file prepped for a 
particular print size, and so on – your best bet is to create a file folder named after your file, 
and store ALL related files in it. 

 

 
 
Here is an example of a file-naming convention that I would use for one image, from a series on Yosemite, file 
#123, shot in June of 2019: 
 

• The very first thing I do: create a separate folder called “2019_06_Yosemite123” to store ALL of 
my files for this image (RAW, PSD, TIFF, JPG, etc.) 

 

• _DSC1234.NEF – This is the original RAW Capture from a Nikon camera ( .CR2 for Canon, etc.) – 
duplicate and rename it through your Operating System before opening it in Adobe Camera RAW 
(discussed in Chapter 10). 
 

• 2019_06_Yosemite123.NEF (& .xmp) - This is the duplicated and renamed RAW file (and its 
accompanying .xmp file),  

 

• 2019_06_Yosemite123_M.tif - This would be the unflattened "Master File”, prepped for proper 
contrast, color, and so on.  This file can be used for a multitude of uses, such as different print 
sizes, web output, etc. 

 

• 2019_06_Yosemite123_11x14.tif - This would start from the Master File.  It would be flattened, 
sharpened and cropped for an 11 x 14 print.  If you have multiple printers, you could even go so far 
as to add an “_E” at the end for an Epson printer, “_L” for a LightJet printer, and so on. 

 

• 2019_06_Yosemite123_5x7_72ppi.jpg - This also starts from the master file, then flattened, 
sharpened, and cropped for a 5 x 7 print.  The file resolution is also reduced to 72 PPI, (rather than 
the normal 300 PPI for printing) so that it’s more adaptable for use on the Web. 
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